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Foreword

Please read this chapter carefully before using this product!

This chapter introduces the safety precautions before using this product. Please
make sure the content of this chapter is fully read and understood before installation
and usage. Our company will not undertake any responsibilities for any damage or
injury caused by improper operations because of ignoring relevant warning in this
operation instruction.

Before operating this device, relevant professional personnel shall read this
instruction carefully and well understand the content.

Operation instructions and warnings:

The following standard definitions will be adopted in this operation instruction.

Danger! Ignoring of safety precautions may cause personal death, serious personal
injury or serious equipment damage.

Warning! Ignoring of safety precautions may cause personal death, serious
personal injury or serious equipment damage.

Caution! Ignoring of safety precautions may cause a slight personal injury or
equipment damage, especially the damage of device or the equipment protected by
the device.

 Danger!

When the primary system is live working, secondary open circuit for the current
transformer connected to the device is absolutely forbidden, and the open of this
circuit may cause extremely dangerous high voltage.

 Warning!

Some parts of the device may have high voltage when the electrical device is running.
Improper operation may cause serious personal injury or equipment damage.

Only qualified professional personnel are allowed to operate the device or work
nearby the device. The operators professional shall well understand the precautions,
working flows and safety regulations mentioned in this instruction.
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 Caution!

Grounding terminals of the device shall be firmly grounded.

The device is only permitted to run in atmospheric environment that specified in the
technical specifications, and abnormal vibrations shall be avoided in its running
environment.

When connect the AC voltage current circuit or power circuit, please make sure they
conform to the rated parameters of the device.

When the output terminals of the device are connected to external circuit, please
check carefully the voltage of external power to prevent overheating of the circuit.

Carefully check the cable connected to the device, preventing applying too much
external force on it.
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Chapter 1: Overview

1.1 Description

F-FTU200 overhead line protection switch intelligent controller is medium voltage
overhead line grid monitoring unit, it can be equipped with F-OCB100 type vacuum
circuit breaker for achieve of automatic monitoring, fault analysis and event records.

Its given to us a safety power grid for cutting line fault and automatic recovery
operation and power automation.
F-FTU200 series is suitable for up to 35kV outdoor switchgear using, include:
vacuum circuit breakers, oil circuit breakers and gas circuit breakers.
F-FTU200 intelligent controller is gathering with line protection, control,
measurement and monitoring of voltage and current signals integrated automation
and control devices outdoors.

F-FTU200 is an automatic management unit for single way/multi ways/ring
network/two power sourcing, provided with all voltage and current signals and all
functions.
F-FTU200 column switch intelligent controller supports:
Wireless (GSM/GPRS/CDMA), Ethernet mode, WIFI, optical fiber, power line carrier,
RS232/485, RJ45 and other forms of communication, and can access other station
premises equipment (such as TTU, FTU, DTU, etc.).

1.2 Protection

49 Thermal Overload (Over load)

50 Instantaneous Overcurrent (Ph.OC)

50G/N/SEF Instantaneous Sensitive Earth Fault (SEF)

27/59 Under/Over Voltage (Ph.OV/Ph.UV)

51c Cold load pickup (Cold load)

1.3 Supervision

60CTS CT Supervision

60VTS VT Supervision

1.4 Control

79 Auto Reclose

86 Lockout

CB Control



6

1.5 Features

Password Protection – 2 levels.

50Hz systems and two phase/three phase wiring method are available, so that the
use scope of device is extended.

Protection configuration is complete, and all protection functions can be switched on
and off flexibly.

4-way intellectual switching value input.

Large capacity flash memory can record at least 100 times of historical events, and
no data will loss even the power is off.

Circuits operating loop can be used both the direct or alternating current, self-
adaptation open/close brake function, which can co-work with various of breakers,
and the operation is simple and reliable.

The device has complete self-inspection function to in-service monitor the working
conditions of various parts of the device, ensuring the reliability of the device.

1.6 Monitoring Functions

Primary Currents Phases and Earth Direction

Secondary PT Voltage

Frequency

Binary Input/Output status

Trip circuit healthy/failure

Time and date

Fault records

Event records

1.7 Hardware

4CT 1 VT 7 Binary Inputs 2 Binary Outputs

4CT 2 VT 7 Binary Inputs 2 Binary Outputs



7

1.8 Data Storage and Communication

RS485, RS232, RJ45 port

Protocols –IEC60870-5-101, IEC60870-5-104, DNP3.0 or Modbus RTU

Event Records

Fault Records

Measurands

Commands

Time Synchronism

Viewing and Changing Settings
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Chapter 2: Technical Performance Index

2.1 Inputs and Outputs

Phase Current Inputs

Quantity 3

Rated Current In 5A

Measuring Range 20 x In

Instrumentation≥ 0.1xIn ±1% In

Frequency 50Hz

Thermal Withstand:

Continuous

10 Second

1 Second

2 x In

10 x In

40 x In

Burden @ In ≤0.2VA (5A Phase element)

Sensitive Earth Current Inputs

Quantity 1

Rated Current In 5A

Measuring Range 2 x In

Instrumentation≥ 0.1xIn ±1% In

Frequency 50/60Hz

Thermal Withstand:

Continuous

10 Second

1 Second

2 x In

10 x In

40 x In

Burden @ In ≤0.02VA (1A Earth element)
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Voltage Inputs

Quantity 1 PT voltage

Nominal 40…120 Vrms

Operating Range 0...200 Vrms

Instrumentation≥0.8xVn ±1% Vn

Burden @ 110V 0.06 VA

Overvoltage Withstand 240 Vrms

Auxiliary Supply

DC Voltage 220V

Range 165 to 365V

AC Voltage 220 V AC 50Hz

Range 165 to 265Vrms AC

50/60Hz ±5%

Power consumption ≤10W

Binary Inputs

Number 7

Operating Voltage 24V DC

Maximum dc current for operation 2mA

Binary Outputs

Number 2

Operating Voltage 220V DC

Operating Mode User selectable - Self or
Hand/Electrical Reset or pulsed

Operating Time from Energizing Binary
Input

<20ms

2.2 Unit Design

Indication 16 Character 4 line Display 10 LED’s

User Interface 11 Navigation Keys

Weight 18kg
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2.3 Serial Interface

Communication Port RS485, RS232, RJ45

Protocols IEC60870-5-101

IEC60870-5-104

DNP3.0

2.4 Data Storage

MODBUS RTU

Events 100 times

2.5 Mechanical Tests

Vibration (Sinusoidal) --- IEC 60255-21-1 Class I

Type

Vibration

Vibration

response

withstand

Level

0.5gn

1.0gn

Variation

≤5%

≤5%

Shock and Bump --- IEC 60255-21-2 Class I

Type

Shock response

Shock withstand

Bump test

Level

0.5gn, 11ms

15gn, 11ms

10gn,16ms

Variation

≤5%

≤5%

≤5%

Shock and Bump --- IEC 60255-21- 3 Class I

Type Level Variation

X-plane-3.5mm

Displacement

below crossover

freq (8-9Hz) 1gn

Seismic response
and above

Y-plane-1.5mm

Displacement

below crossover

freq (8-9Hz)

0.5gn above

≤5%
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Mechanical Classification

Durability >106 operations

2.6 Electrical Tests

Insulation --- IEC 60255-5

Type Level

Between any terminal and earth 2.0 kV AC RMS for 1 min

Between independent circuits 2.0 kV AC RMS for 1 min

Across normally open contacts kV AC RMS for 1 min

High Frequency Disturbance --- IEC 60255-22-1 ClassⅢ

Type

Common (longitudinal) mode

Series (transverse) mode

Level

2.5 kV

1.0 kV

Variation

≤5%

≤5%

High Frequency Disturbance --- IEC 60255-22-2 ClassⅣ

Type

Contact discharge

Level

8.0 kV

Variation

≤5%

Fast Transients --- IEC 60255-22-4 Class A (2002)

Type

5/50 ns 2.5 kHz repetitive

Level

4 KV

Variation

≤5%

Surge Immunity --- IEC 60255-22-5

Type Level Variation

Analog Inputs:

Line to Earth

4.0 kV ≤10%

Case, Aux Power & I/O: Line to Earth 2.0 kV ≤10%

RS485 Comms port: Line to Earth 1.0 kV No Data Loss

Analog Inputs:

Line to Line

1.0 kV ≤10%

Case, Aux Power & I/O: Line to Line 1.0 kV* ≤10%

* Note 45ms DTL pick-up delay applied to binary inputs
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Conducted Radio Frequency Interference --- IEC 60255-22-6

Type Level Variation

0.15 to 80 MHz 10 V ≤5%

Radiated Radio Frequency --- IEC 60255-25

Type Limits at 10 m, Quasi-peak

30 to 230 MHz 40 dB(µV)

230 to 10000 MHz 47 dB(µV)

Conducted Radio Frequency

Type Limits

Quasi-peak Average

0.15 to 0.5 MHZ 79 dB(µV) 66 dB(µV)

0.5 to 30 MHZ 73 dB(µV) 60 dB(µV)

Radiated Immunity --- IEC 60255-22-3 ClassⅢ

Type Level

80 MHz to 1000 MHz Sweep 10 V/m

1.4GHz to 2.7GHz Sweep 10 V/m

80,160,380,450,900,1850,2150 MHz Spot 10 V/m

2.7 Climatic Tests

Temperature --- IEC 60068-2-1/2

Operating Range -55°C to +70°

Humidity --- IEC 60068-2-78

Operational test 56 days at 40°C and 93%

relative humidity
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Chapter 3: Protection Functionality

3.1 Function Description

Under Voltage (Ph.UV)

PT voltage is used as the criterion of undervoltage protection. There are two sections
of undervoltage protection here.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
UAB—Secondary PT voltage Uset—Pickup voltage T—Delay time

Power on

The device will control the CB to close when the PT voltage greater than pickup
voltage.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
UAB—Secondary PT voltage Uset—Pickup voltage T—Delay time

Over Voltage (Ph.OV)

PT voltage is used as the criterion of over-voltage protection. There are two sections
of overvoltage protection here.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
UAB—Secondary PT voltage Uset—Pickup voltage T—Delay time
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51c Cold Load Pickup (Cold Load)

If a circuit breaker is closed onto a “cold” load, i.e.one that has not been powered for
a prolonged period, this can impose a higher than normal load-current demand on
the system which could exceed normal settings. These conditions can exist for an
extended period and must not be interpreted as a fault. To allow optimum setting
levels to be applied for normal operation, the cold load pickup feature will apply
alternative current settings for a limited period. The feature resets when either the
circuit breaker has been closed for a settable period, or if the current has reduced
beneath a set level for a user set period.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
IA IB IC—Measured current I’set—Cold load pickup current

Iset—Ph.OC pickup current T—Delay time

50P Phase Fault (Ph.OC)

Three sections phase overcurrent protection for lines include Ph.OC1 (instantaneous
overcurrent protection), Ph.OC2 (definite time overcurrent protection) and Ph.OC3
(overcurrent protection). All of which are definite time actuate features.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
IA IB IC—Measured current Iset—Pickup current T—Delay time

50G/50N Sensitive Earth Fault (SEF)

When the switch is set at the end of the line, the zero sequence current can be used
to protect the earth fault when the capacitance of the power supply side to the earth
is large and the capacitance of the load side to the earth is small.

When the switch is set at the end of the line, the ground fault on the load side of the
switch can be detected only according to the zero sequence current. However, if
there is a large capacitance to ground on the load side, it is possible to detect the
zero sequence current and misoperate when there is a ground fault on the power
side. Therefore, it is necessary to judge the direction and fault point of the grounding
current according to the amplitude of the zero sequence current and the phase angle
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Note: Run is “√”，Stop is “×”.
3I0—SEF current
θ1—Start angle

I0set—Pickup current
θ2—End angle

T—Delay time

between the zero sequence voltage and the current, in order to prevent this
unnecessary misoperation.

The angle between zero sequence directionality refers to the angle between zero
sequence voltage and zero sequence current and the angle of zero sequence current
leading to zero sequence voltage. When conducting zero sequence directionality test,
the starting angle and ending angle of zero sequence action interval can be modified.
After being put into operation, the zero sequence current in the section shall exceed
the set value, and the zero sequence directional protection can only operate,
otherwise it will not operate.

For example, the start angle of zero sequence action section is set to 240 ° and the
end angle of zero sequence action section is set to 300 °. At this time, enter the
“VIEW” → “Meter” menu to check the angle of IU0an (IU0an is the angle of zero
sequence current ahead of zero sequence voltage). Only when it is between 240 ° ~
300 ° and the zero sequence current exceeds the set value, the zero sequence
directional overcurrent will act, otherwise it will not act.
Action Logic diagram：

IU0an—Angle of zero sequence current ahead of zero sequence voltage

Note: If zero sequence directional overcurrent protection is required, it shall be
specified when ordering. The normal delivery is zero sequence overcurrent without
direction.

79 Auto - Reclose (Reclose)

A high proportion of faults on an overhead line network are transient and can be
cleared quickly by high speed tripping followed by an automated circuit breaker
reclose sequence.

The function provides phase fault and earth fault/sensitive earth fault sequences of
up to 5 trip i.e.4 reclose attempts before lockout, and the charging period of the
reclose is 10 seconds.
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Action Logic diagram：

Reclosing acceleration (Recl.ACC)
Note: Run is “√”，Stop is “×”.

When switching on reclosing acceleration, if accidents happened in 3S after the
reclose is operated, the phase over current protection will accelerate the operation.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
IA IB IC—Measured current Iset—Pickup current T—Delay time

Manual closing acceleration (Manu.ACC)

When switching on manual closing acceleration, if accidents happened in the exit
time after operated the close, the phase over current protection will accelerate the
operation. The exit time of acceleration can be adjusted.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.
IA IB IC—Measured current Iset—Pickup current T—Delay time
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Prepaid (Optional features)

It is used to connect the dosing tank, the device will control the CB to trip when the
dosing tank is in deficit.
Action Logic diagram：

3.2 Constant Value Parameters
Note: Run is “√”，Stop is “×”.

All values are given primary side.
Under Voltage (Ph.UV)

Description Setting range Step length
Operating mode 1. Trip 2. Alarm

PH.UV

Power on

Pickup voltage 0.01～42KV 0.01KV
Delay time 0～99.99S 0.01S

Description Setting range Step length
Pickup voltage 0.01～42KV 0.01KVPower on Delay time 0～99.99S 0.01S

Over Voltage (Ph.OV)

Description Setting range Step length

PH.OV Pickup voltage 0.01～42KV 0.01KV
Delay time 0～99.99S 0.01S

51C Cold Load Pickup (Cold load)

Description Setting range Step length

Cold load Pickup current 1～6000A 0.1A
Delay time 0～99.99S 0.01S

50P Phase Fault (Ph.OC)

Description Setting range Step length
Pickup current 0.1～6000A 0.1APH.OC1

PH.OC2

PH.OC3

Delay time 0～9.99S 0.01S
Pickup current 0.1～6000A 0.1A
Delay time 0～9.99S 0.01S
Pickup current 0.1～6000A 0.1A
Delay time 0～99.99S 0.01S

50G/N Sensitive Earth Fault (SEF)

Description Setting range Step length
SEF Operating mode 1.Alarm 2.Trip
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Pickup current 0.1～999.9A 0. 1A
Delay time
Start angle
End angle

0～600S/M
0～360°
0～360°

0.1S/M
1°
1°

79 Auto - Reclose (Reclose)

Description Setting range Step length

Reclose count 1:One 2:Two 3:Three 4:Four
Reclose Delay time 0～99.99S 0.01S

Reset time 1.2～180S 0.1S
Reclosing acceleration (Recl.ACC)

Description Setting range Step length

Pickup current 0.1～6000A 0.1ARecl.ACC Delay time 0～9.99S 0.01S
Manual closing acceleration (Manu.ACC)

Description
Exit time

Setting range
0.1～9.99S

Step length

0.01S
Manu.ACC Pickup current

Delay time
0.1～6000A
0～9.99S

0.1A
0.01S

Prepaid (Optional features)

Description Setting range Step length

Prepaid Delay time 0～99.99S 0.01S
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Chapter 4: User Interface

The operator interface is designed to provide a user friendly method of controlling,
viewing menus, entering settings and retrieving data from the relay. 11 buttons are
provided for navigation around the menu structure.

4.1 LEDs

Operation Status Operation Status



20

LED Categories LED Status

Name Color ON OFF Flashing

Run Green crash crash Working
properly

Commu Green No communication No communication Normal
communication

Alarm Yellow Device failure or
protection alarm

Running normally ——

Closed Red Switch is on Switch is not on ——

Opened Green Switch is off Switch is not off ——

Action Red Protective action No protective
action

——

Reclos Red Reclose export Normal ——

OC.F Red Over current alarm Normal ——

Earth.F Red Ground fault action Normal ——

Lockout Red Reclosing lockout
alarm

Normal ——

4.2 Keypad
The main keys

User actions are mainly concentrated on the operation panel.

Key Function
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Increase the number

Reduce the number

Move up or page up

Move down or page down

Move left

Move right

Return to the superior or Cancel the operation

Enter the menu of confirm the operation

When you press the button，the buzzer of device will sing make a sound，so that
the operation is valid; if not, please do it again.

Operation buttons

Key Function

Touch reset button, you can reset protect information

Touch closing button, close switch

Touch tripping button, trip switch

When you press the button，the buzzer of device will make a sound，so that the
operation is valid; if not, please do it again.

Note: When you press the closing-button or tripping-button, you must make sure the
device is unlock; if the lockout-light is on, please press the reset-button to reset the
device, so that you can close or trip the switch.
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Switch rocker

Key Function

When the rocker is switched to the local, only the opening
and closing operation can be carried out on the panel or
remote control; when the rocker is switched to the remote,
only the communication opening and closing operation can
be carried out.

4.3 LCD

A 4 line by 16 character liquid crystal display with power save operation indicates the
relay identifier, settings, instrumentation, fault data and control commands.

4.4 The Main Menu

Press “Enter” when on the main screen, as shown below, including “EDIT” and
“VIEW” menu item. Select the corresponding menu item with the [←] key, [→] and
press "Enter" button to enter the corresponding sub-menu, press the “ESC” key to
return to the previous screen.

Primacy Menu
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4.5 Submenu
Edit submenu

Choose the edit options, the screen will enter the submenu of the Edit menu, as
shown below, the submenu includes “Relay”、“Para”、“Chnl”、“Clr”、“Time”、
“Comm”、 “Fac”、 “Test”.

Submenu of edit

Enter “Relay” submenu, you can modify the protection feature.

Enter “Para” submenu, you can modify or view other parameters. Like
communication address, baud rate, password, trip and close pulse time.

Enter “Adj.” submenu, current and voltage values can be corrected,
press the function key "Enter" to be modified.

Enter “Clr.” submenu, you can clear out the trip report, the alarm
report, the SOE report, the count report and all report.

Enter the “Time” submenu will modify or check the time.

Enter “Comm” Sub-menu, choose the way to communication, it include
“GSM”and “GPRS”.

Enter “Fac.” Sub-menu, modify and view the factory settings.
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View submenu
Choose the view options, the screen will enter the submenu of the View menu, as
shown below, the sub-menu includes “Meter”, “RPT”, “Relay”, “Input”, “Ver”.

View submenu

Enter “Meter” submenu, you can view the primary side measurement
data include: PT voltage, phase current, zero sequence current,
frequency, phase angle.

Enter “RPT” submenu, you can view trip report, alarm report, SOE
report, count report.

Enter “Relay” submenu, you can view each protection feature is
invested and set up the parameters

Enter the “Input” submenu, you can view the input signal. The input
signal includes: Breaker close, Prepaid open, Prepaid close, Spring
ready.

Enter “Ver” submenu, you can view the product model, serial
number and date of manufacture.
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4.6 Entering the password interface
According to the above operation, before entering each item will first enter a
password input interface to prevent professional staff misuse. The device original
password is “0099”, as shown below, press [←] and [→] keys to switch, press the
[+] and [-] keys to increase and decrease the number of line with the correct
password press “Enter” button to enter.

Password interface

4.7 Relay setting

Select the “Relay” in the Edit submenu item, press the function key “Enter” to enter
the password screen, enter the correct password to enter the “Relay” submenu, as
Shown below, each item has a checkbox and set values.

1. Ph.OC1: instantaneous overcurrent Protection
2. Ph.OC2: definite time overcurrent protection
3. Ph.OC3: overcurrent protection
4. SEF: sensitive earth fault protection
5. Cold Load: cold load pickup
6. Reclose: OC reclose
7. Recl.ACC: reclosing acceleration protection
8. Manu.ACC: manual closing acceleration protection
9. PH.OV: overvoltage protection
10. PH.UV: low voltage protection
11. Power on: power on protection
12. Prepaid: debt protection
23. Power Alm: stored energy alarm
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Three sections phase overcurrent

Select Ph.OC menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the overcurrent protection
current value, the current value can be
between 0.1A ~ 6000A.

Step 2: Setting the overcurrent delay time, the
delay time can be between 0S ~ 9.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of simple overcurrent protection setting

Note: Here are three-stage overcurrent protection, the use of the other two are the
same.

Sensitive earth fault

Select SEF menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the SEF operating mode (1:
Alarm 2: Trip 3: Direction alarm 4: Direction
trip).

Step 2: Setting the SEF protection current
value, the SEF current value can be between
0.1A ~ 999.9A.

Step 3: Setting the SEF delay time, the delay
time can be between 0 ~ 600.0S/M.

Step 4: Setting the SEF start angle, the angle
can be between 0 ~ 360.

Step 5: Setting the SEF end angle, the angle
can be between 0 ~ 360.
Note: 1.Press [↓] key to switch to next
screen, press the [+] and [-] keys to switch
the modified current value and delayed time.
2. Step 4 and step 5 only need to be set when
zero sequence direction overcurrent is
required.

The operational processes of SEF protection setting
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Cold Load

Select Cold Load menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the cold load protection
current value, the current value can be
between 1A ~ 6000A.

Step 2: Setting the cold load delay time, the
delay time can be between 0S ~ 99.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to modified
current value and delayed time.

The operational processes of cold load protection setting

Automatic reclosing (Reclose)

Select Reclose menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Choose the automatic reclosing times
(1: One, 2: Two, 3: Three, 4: Four).

Step 2: Setting the 1st delay time, the delay
time can be between 0S ~ 99.99S.

Step 3: Setting the 2nd delay time, the delay
time can be between 0S ~ 99.99S.

Step 4: Setting the 3rd delay time, the delay
time can be between 0S ~ 99.99S.

Step 5: Setting the 4th delay time, the delay
time can be between 0S ~ 99.99S.

Step 6: Setting the automatic reclosing reset
time, the reset time can be between 1.2S~
180.0S.

Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
mode and modified delayed time/reset time.

The operational processes of automatic reclosing setting
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Reclosing acceleration (Recl.ACC)

Select Recl.ACC menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the reclosing acceleration
protection current value, the current value can
be between 0.1A ~ 6000A.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 9.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of reclosing acceleration protection setting

Manual closing acceleration (Manu.ACC)

Select Manu.ACC menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the manual closing acceleration
exit time, the exit time can be between 0.1S ~
9.99S.

Step 2: Setting the manual closing acceleration
protection current value, the current value can
be between0. 1A ~6000A.

Step 3: Setting the delay time, the delay time
can be between 0S ~ 9.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of manual closing acceleration protection setting
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Over voltage protection (Ph.OV)

Select PH.OV menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the overvoltage protection
voltage value, the voltage value can be
between 0.01KV ~ 42.0KV.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
modified voltage value and delayed time.

The operational processes of overvoltage protection setting

Low-voltage protection (Ph.UV)

Select PH.UV menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the low voltage protection
operating mode (1: Trip 2: Alarm).

Step 2: Setting the low voltage protection
voltage value, the voltage value can be
between 0.01KV ~ 42.0KV.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
modified voltage value and delayed time.

The operational processes of low voltage protection setting
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Power on

Select Power on menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the Power on protection
voltage value, the voltage value can be
between 0.01KV ~ 42.0KV.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.
Note: Press [↓] key to switch to next screen,
press the [+] and [-] keys to switch the
modified voltage value and delayed time.

The operational processes of Power on protection setting

Prepaid (Optional features)

Select Prepaid menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press the [+] and [-] keys to switch the
delayed time.

The operational processes of prepaid protection setting

4.8 Save parameter

After setting, press “ESC” key to exit, if modified below figure will show. If you need
to save press “Enter” key and input password, otherwise press “ESC” key.
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4.9 Parameter set
Press the EDIT → Para, enter the “parameter set”. Press the [+] and [-] keys to
modified parameter value.

CT, CT0 rate set

CT rate is the three phase current rate.
The value of CT ratio is equal to the
primary side current value divided by
the secondary side current value.

CT0 rate is the real zero sequence
current rate. The value of CT0 ratio is
equal to the primary side current value
divided by the secondary side current
value.

PT rate is the power voltage rate. The
value of PT ratio is equal to the primary
side voltage value divided by the
secondary side voltage value.

Note:

1 Different current transformer, CT ratio becomes different.

2 Different current transformer, CT0 ratio becomes different.

3 Different PT power voltage transformer, PT ratio becomes different.

Wiring mode set

Phase current wiring mode.

Thr.: Three-phase

Two: Two-phase

zero sequence current wiring mode.

Comp: Synthetic zero sequence

Real: Real mining zero sequence

Note: The wiring mode must be the same as that of the circuit breaker.
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Close and trip pulse time set

“Close pulse time” is the discharge time for close coil. “Trip pulse time” is the
discharge time for trip coil.

Note: Please do not modify the trip and close pulse time.

Password set

The device initial password is “0099”,
the password for the user to modify
from the “0000” ~ “9999”, when revised
press “Enter” key to confirm, enter the
password before the modification.

Set the communication parameter

Name Setting range Step length Description

Comm1 Status 0～1 1 0: Close this channel
1: Open this channel

Comm1 Baud 0～38400 1 Default 9600
1: IEC60870-5-101

Comm1 Protocol 1～4 1 2: IEC60870-5-104
3: DNP3.0
4: MODBUS

Comm1 Balance 0～1 1 0: Unbalanced
1: Balance

Comm1 Address 1～65535 1 Source address
Comm1 Report 0～65535 1 Destination address

Comm1 Upload 0～1 1 0: Do not upload actively
1: Active upload

Comm2 Status 0～1 1 0: Close this channel
1: Open this channel

Comm2 Baud 0～38400 1 Default 9600
1: IEC60870-5-101

Comm2 Protocol 1～4 1 2: IEC60870-5-104
3: DNP3.0
4: MODBUS

Comm2 Balance 0～1 1 0: Unbalanced
1: Balance

Comm2 Address 1～65535 1 Source address
Comm2 Report 0～65535 1 Destination address

Comm2 Upload 0～1 1 0: Do not upload actively
1: Active upload
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Address len 1～2 1

COT len 1～2 1
1: 1 byte 2: 2 byte
COT length
1: 1 byte 2: 2 byte

I factor 0.01～100 0.01 Phase current multiplier
I deadband 0.1～1000 0.1 Phase current dead zone
I0 factor 0.01～100 0.01 Zero sequence current multiplier
I0 deadband 0.1～1000 0.1 Zero sequence current dead zone
U factor 0.01～100 0.01 Line voltage multiplier
U deadband 0.1～1000 0.1 Line voltage dead zone
U0 factor 0.01～100 0.01 Zero sequence voltage multiplier
U0 deadband 0.1～1000 0.1 Zero sequence voltage dead zone
P factor 0.01～100 0.01 Power multiplier
P deadband 0.1～1000 0.1 Power dead zone
COS factor 0.01～100 0.01 COS multiplier
COS deadband 0.1～1000 0.1 COS dead zone
OTH factor 0.01～100 0.01 Other multiplier
OTH deadband 0.1～1000 0.1 Other dead zone
CLASSA 0～3 1 Class for analog event data
CLASSB 0～3 1 Class for digital event data
Select Timeout 0～30 0.1 Select/operate time-out
Confirm Link 0～1 1 Enable confirm data link
Link Retry Times 0～15 1 Data link retries times
Link Timeout 0～50 0.1 Seconds to data link time-out
Upload Confirm 0～1 1 Enable upload confirmation
Upload Timeout 0～50 0.1 Seconds to upload time-out
Upload Retry Times 2～10 1 Upload retries times
Auto Refresh 0～1 1 Enable automatic reset of events
Refresh time 0～65535 1 Seconds to automatic reset event

Signal type 1～2 1 1: Single point
2: Double point

Control type 1～2 1 1: Single point
2: Double point
1: Normalized telemetry
2: Normalized telemetry without

Meter type 1～4 1 quality
3: Standardized telemetry
4: Short floating point telemetry
Address length
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4.10 Calibration

Select the Edit submenu in “Adj.”, press “Enter” key to enter into the password
screen, enter the correct password to enter the “Adj.” submenu, press the [+] and [-]
keys to correct the value of current and voltage.

Note: All voltage and current values in the factory have been corrected before.
Please do not change the parameter values.

4.11 Clear report

Select the Edit submenu in “Clr”, press “Enter” key to enter, as shown below:
Select “1”: Clear the trip report.

Select “2”: Clear the alarm report.

Select “3”: Clear the SOE report.

Select “4”: Clear the count report.

Select “5”: Clear the all report （include trip
record, alarm record, SOE record and count
record）.

4.12 Factory setting

All the values in the factory have been corrected before. Please do not change the
values.

4.13 View primacy meter

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Meter” option to press “Enter” key to enter the “Primacy Meter” submenu,
you can view all the primacy meter value.

1. Ia: Primary side current of phase a
2. Ib: Primary side current of phase b
3. Ic: Primary side current of phase c
4. 3I0: Zero sequence primary current
5. UAB: Line voltage UAB primary side value
6. UBC: Line voltage UBC primary side value
7. F: Frequency
8. P: Active power
9. Q: Reactive power
10. AP: Apparent power
11. COS: Power factor
12. Iaang: Angle of phase a current
13. Ibang: Angle of phase b current
14. Icang: Angle of phase c current
15. I0ang: Angle of zero sequence current
16. Uaang: Angle of line voltage UAB
17. Ubang: Angle of line voltage UBC
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4.14 View SOE

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select “RPT” option press “Enter” key to enter the “RPT” submenu, you can view the
SOE record events, recording events include: trip signal, alarm signal, telemetry
signal (circuit breaker status, whether the manual or remote operation, fault trip,
time and date, etc.) and count signal (the count of trip).

4.15 View relay and setting

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Relay” option to press “Enter” key to enter the “Relay” submenu, you can

view all the protection is enabled or disabled, select the option press “Enter”
key to enter the value you can view each protection, press the arrow keys to switch
screens.
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4.16 View input signal

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Input” option press “Enter” key to enter the “Input” submenu, you can
view the state of input signal.

4.17 View version information

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Ver” option press “Enter” key to enter the “Ver” submenu, You can view
the device type, version number, production date, and device ID.
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Chapter 5: Peripheral Accessories

5.1 RF remote controller

Function of each key

A:Close

B:Trip

C:Unlock

D:Reset

Note:
1. In order to prevent misuse, press the unlock button for 3 seconds, before
execution of the closing operation.
2. The effective distance of RF remote controller is 30 meters.

5.2 Features and the use of external sockets and switches

AC power switch Backup switch Activation button

Note: Before using the controller, ensure that the battery charge enough for 12
hours.

1. The AC power switch is for protecting the Auxiliary PT (Or utility incomer), and the
BACKUP switch is for charging batteries.
2. After charging the batteries, turn off the power switch to protect the batteries for
storage.
3. Activation button is not allowed for pressing last long time, or permanent damage
of battery under-voltage may result.
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5.3 The main secondary component parts

Cable plug, connect the controller and
circuit breakers.

Cable plug, connect the controller to
offer the power.

Note: For security norms, Surge protector has to be grounded (green line) to the
earth.

5.4 Battery

 F-FTU200 stand-by battery adopts two 7AH lead-acid free of maintenance
batteries, the average battery life exceeds 3 years.

 Please replace the storage battery in time when the storage battery exceeds its
usage life. Replace method as following: firstly push the stand-by power supply
switch to trip position, and pull out the connection cable simultaneously, rotate
the support bolt away, replace the used battery with new battery. Then recover
the device to the original status according to the contrary sequence. Please deal
with the used battery properly in order not to pollute the environment.
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Chapter 6: Installation and Maintenance

Danger: The dangerous voltage with the device maybe result in the permanent
damage of equipment or personnel casualty during installing F-FTU200. These
voltages mainly distributes at terminal bar of device and circuits of AC current input,
AC voltage input, digital input, IGBT output and operation power supply., etc. This
device’s installation, debugging and maintenance can only be operated by technical
staff who has been authorized and trained strictly.

6.1 Installation

F-FTU200 series installation schematic and dimensions

Cabinet installation

Installation of Box Body

 Please fasten it upon support shelf with matched M10 × 20 stainless bolts during
installing the product. (Support shelf is provided by user, please point it out if
needed to be provided by manufacturer)

 As shown above, place it up side. Don’t place it up side down or in slope.
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6.2 Maintenance

 If the device is not used, it should be kept in dry and ventilated places indoors,
and charged once every three months, the charging time should be more than
24 hours. Before the device is used, the charging time should not be less than
24 hours. Replace the storage battery each three years.

 This device has storage battery management module, which will automatically
cut off the storage battery output circuit when the storage battery voltage is on
the low side. You should check the storage battery each year, please replace the
storage battery immediately when single storage battery voltage id lower than
DC12V.

 Please firstly make sure the first system is power off before the device is
maintained, forbid inserting or pulling out aeronautical connector under power,
thus avoid CT short circuit happening.

6.3 Parts Attached with the Device

Name Quantity Collocation Usage or Description

Box door key 2 Standard Open the box

User Manual 1 Standard
Please read it carefully before
use the device, MC501 wiring

diagram is attached.

Inspection report 1 Standard Factory inspection report

Hand-held
telecontroller

Communication
Interface

1 Selectable Telecontrol the close and trip of
switch within 30 meters

1 Selectable RS485/USB converter or
RS485/RS232 converter

Control Cable 1 Standard 20 cords (6 meters)

Control Cable 1 Standard 2 cords (6 meters)
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Chapter 7: Decommission and Disposal

7.1 Decommission

Shut-down Power Supply

Shut-down Device Power Supply: Turn off external power supply switch of the device.

Disconnect All Power Cables

Disconnect all power cables connected to the device.

Danger: Before disconnecting all power cables connected to the device power module,
it must confirm that the external power switch is turned off to avoid danger.

Danger: Disconnecting all power cables connected to the device alternating current
module, it must confirm that the equipment corresponding to input alternating
component has stopped operation to avoid danger.

Dismantle from Display Cabinet

When the above steps are completed, loosen the fix screws and dismantle the device
from the display cabinet.

Danger: When neighboring equipment is in operation, it must strictly confirm the
safety distance between the dismantled device and other device in operation and
unskilled professional shall take particular caution.

7.2 Disposal

When dispose decommissioned device, please follow relevant regulations of the
country where the product is used for the disposal of scrapped electronic products.

Caution: It must strictly adhere to relevant regulations of the country where the
product is used for the disposal of scrapped electronic products.
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